
Introduction

Wave Flow is an audio editor, so it can play, record, filter and modify a waveform, using lots 
of different functions, always following the WAV standard. Besides, as it has been designed for a 
Windows environment, it is done visually, easily and intuitively. 

Those characteristics are obtained building a program that supports multiple windows or 
MDI documents (multiple document interface). Allowing the use of different windows 
simultaneously, the work that have to be done gets easier . If you have ever used a program not 
supporting MDI, you know that to interact between two or more waves, multiple sessions of the 
same program must be opened, but using a MDI program, there is no need to open more than one 
session of the program, because as many files as wanted can be opened from it, and they will be 
displayed in their respective child windows.

Once a sound is opened, it will be displayed in a child window, showing its characteristics in 
the status bar of each window. Clicking with the mouse on a child window will activate it. After 
selecting a part of the sound (keeping the left mouse button pressed over the sound), as many 
functions of the main program can be used.



The main program

The appearance and the use of Wave Flow, is very intuitive because it contains button bars, a 
menu and other visual elements. Besides, each button has a small hint (little help that appears 
when the mouse pointer is over a component a few seconds). 

The bars that appear in the main program are the next:

- Speed bar
- Options bar
- Play bar 
- Selection bar

Besides, the menu options can be divided into:

- File menu
- Edit menu
- Tools menu
- Filter menu
- Miscellaneous menu



Speed Bar

Four buttons can be found in this bar. They allow you have a quick access to a set of file 
options that can also be found into the File menu.

The available buttons are:

- New
- Open
-Save
-Save selection



Options Bar

This bar contains the buttons that allow a quick access to the most useful functions of the 
program. It is a multiple level bar, so more buttons in less space can be displayed. The buttons 
are classified into three levels: Edit, Tools and Filter.

The first level contains the speedbuttons    that allow a quick access to the next functions: 
Cut, Copy, Paste, Mix, Repeat, Force silence, Delete    and Undo.

In the second level (Tools), the next buttons can be found: Speed up/down, Efects, Reverb, 
Reverse, Normalize, Fade In, Fade Out i Amplify Volume.

In the third level (Filter) the next functions can be found: Advanced filter, Filter bank, 
Equalize, Low pass filter, Band pass filter, High pass filter, Median filter and Dynamic expander.



It is a filter that deletes the High frequencies, but allowing the pass of the low frequencies.



It is a filter that deletes the High and low frequencies, but allowing the pass of the medium frequencies



It is a filter that deletes the low frequencies (except for the offset component), but allowing the pass of the high 
frequencies.



Play Bar

This bar contains the buttons that not only will let you play a part of a waveform, but also 
will let you pause, stop and record it. 

The button with a CDROM Image (on the right of the Play Bar), shows a very easy and 
visual CD player, That will let you play any music CD.



Selection Bar

The selection bar, has three components. The first one (titled Begin), will let you display and 
change the beginning of the actual window, that can scroll through the waveform. The second 
one (Size), will let you change the selection size in samples. The Zoom edit box, will let you see 
and change the scale that will be used to display the waveform.



FAQs

1.-) I like your program and I would like to register it. What do I have to do?

You can register Wave Flow using any of these ways:    First of all, you can register it online 
using Internet and a secure shareware registration service. Please visit Wave Flow Web Site at 
http://www.waveflow.com to register this way. If you do not want to register online, you can also 
send me the money to my postal address. This method is not as fast as the first one, and it is 
recommended if you do not have a credit card. To register this way, please take a look to the 
Register help page for more information.

2.-) I have a sound and it is not displayed completely. Is there any problem with the 
shareware version?

No. If this happens is probably because you have recorded the sound using a program that 
does not follow the WAVE RIFF format correctly. This happens for example with the Windows 
Sound Recorder. You can solve it using a file converter or another audio editor and re-saving the 
waveform (so it will be saved with the correct file format).

3.-) My sound is huge (50 Mb). What can I do to use it with Wave Flow?

Wave Flow has some problems in some systems when you are trying to use a huge file. This 
can be solved using a Wave Flow function called Divide into multiple waveforms, that divides 
your file into multiple shorter files so you can use them in Wave Flow.

4.-) Where can I find the last version of Wave Flow and some information about it?

You can visit Wave Flow web site at http://www.waveflow.com (European mirror) or 
http://sagat.hypermart.net (USA mirror).

5.-) I have songs in cassettes and I would like to convert them to CD. Can your software do 
it?

You can use my program to record those songs into .wav files, and then use the program that 
comes with your CD Recorder (EasyCD or whatever) to convert them to CD tracks.

6.-) During the setup process I leaved the option ‘Use as default audio editor/CD Player’ 
checked. How can I unset Wave Flow as default?

If you have 3.2 version or higher you can use the option ‘Colors and settings’ in the 
Miscellaneous menu. Otherwise you will have to use the regedit.exe and delete all 
‘waveflow.exe’ keys.

7.-) What do I get if I register Wave Flow?

If you register, you will become a happier person because you will do the right thing (and the 



legal thing). You will not only have technical support, but also you will get free upgrades to all 
the versions of the same number (3.0, 3.2, 3.5, …), and an special discount (60%) to all future 
versions (4.x, 5.x, …). In addition, you won’t have to see the annoying message recommending 
you to register every 5 minutes.

8.-) I have a sound with music and voice, and I would like to remove the voice from it. How 
can I do it?

In audio waveforms, it is impossible to completely discriminate the sound of the voice and 
the sound of the music from a recorded waveform, because they are all mixed together in the 
same track. You can try to use a function called ‘karaoke’ to try to simulate it.

9.-)    I need to remove the background noise of my sound. Which functions do I have to 
use?

It depends on the sound, so you will have to try different combinations of the next functions: 
STSA, noise gate and High pass filter.

10.-) I want to remove the scratches from my vinyl records. What do I have to do?

It depends on the sound, so you will have to try different combinations of the next functions: 
Top Hat filter, Median filter and Low pass filter.
 
11.-) I get error MMSystem # . Why?

Wave Flow uses Windows multimedia functions (low level audio controller functions) to play 
the sound. Check if your drivers are Ok or try to re-install them.

12.-) I would like to distribute Wave Flow with my magazine, CD, Web, … Can I do it?

Of course. Shareware philosophy means that it is free to distribute and to try, but not to use. 
This means that you can distribute it, but please notify it to me (I like to know where my 
program distributed) to my email account (xevi@100mbps.es).

13.-) I get IOERROR # when I try to open my file. Why?

Please take a look to the FAQ number 3 and check it.



File Menu

You can use the commands on the File menu to manage the audio files in the program. 

The commands on the file menu are the next:

- New
- Open
- Reopen
- Close
- Device information
- File information
- Save
- Save as...
- Exit
- Divide into multiple files
- Concatenate multiple files
- Cd Player
- Save selection
- Print
- Print options



New

Creates a new wave (without any default format). This new wave will be represented as an 
empty window, where any wave can be pasted (previously cut or copied). 

This option can also be called from the speebar.



Open

This command shows a dialog box that lets you choose an already created wave file (files 
with extension *.WAV). Once a file is selected, the program will open it and will display it as a 
wave.

This option can also be called from the speebar. 



Reopen

This command shows the path and the name of the three last wave files that have been 
opened, putting them into a submenu. To open one of this files, select it clicking on its name, and 
the program will open it.



Close

Closes the waveform that is active. If the waveform has been modified in any way, the 
program will ask if you wish to save it. In that case the Save asdialog box will appear.



Device information

When this option is selected, a dialog box is displayed, which contains the characteristics and 
the information about the audio devices installed on the system.



File information

When this option is selected, a dialog box is displayed, which contains the characteristics and 
the information about the audio file that is active. Those characteristics can also be seen in the 
status bar of each window, and the path and the name of the selected file can be seen on the title 
of the its window. 



path, number of channels, bits per sample and samples per second (sample frequency). 



Save

To save a waveform there are two options:

-If the waveform of the active window has a file name, the waveform is saved on the old 
file. The old waveform will be replaced.

-If the waveform has no name (because it is new), the Save as... function will be called. 
You must also use this alternative function if you wish to change the name of the waveform file.

This option can also be found in the speedbar



Save as...

This command shows a dialog box where the final name of the file to be saved can be 
selected. 



Exit

This command lets you close the actual session and exit the program allowing you to 
save the waveform files that have been modified . 



CD Player

When this option is selected, a CD player is displayed on the bottom of the main window. 
This CD player can play, stop, pause, eject, move forward, rewind, move to next and last    track, 
and shows information about the tracks and the time of the CD. It also lets you choose any track 
of the CD only by clicking on its button. 

This option can also be found in the Playbar of the main program. 



Save selection

Lets you save the piece of the waveform that is selected. 

This option can also be found in the speedbar .



Print

Prints the waveform that is active with the configuration and values of the option Printer 
options. It doesn't print all the waveform, only the part that is displayed in the active window 
(including the selection, the selection cursor and the status bar of the window).



 #Printer options

This command displays the dialog box of the default printer installed on your system.



 Miscellaneous Menu

In this menu you will find miscellaneous functions that are not applicable to other menus.

The commands on this menu are the next:

- Colors
- Histogram
- Loop
- Zoom In/Out
- Audio Related Sites



Colors and Settings

Lets you change the colors of the Wave Flow screen (Line, WaveForm and Background). 
This option also lets you set Wave Flow as the default audio player/editor and as the default CD 
player.



Histogram

Lets you see the discrete probability function of the waveform and some extra parameters 
(mean, variance,...), that can be of some help in many cases.



Loop

Lets you select if the play of the sound will be cyclic or it will only be played once (default).



Zoom In/Out

Lets you select the actual zoom of the waveform using hotkeys (Ctrl++/Ctrl+-) with a Zoom 
Step of x2. You can also change the zoom with the zoom edit box or the zoom speedbutton 
placed under the zoom edit box.



Register

Wave Flow is a Shareware program. This means that if you like it after you have tried it or 
you are going to use it for commercial purposes, you must register it. I have put a lot of hard 
work to develop this audio editor, and I need money to continue developing new versions of this 
program.

There are two ways of registering Wave Flow 3.x:

a.-) Online Registration via Internet. You can visit Wave Flow website at 
http://www.waveflow.com and follow the instructions, or you can directly select    Help Menu    
Register    Online Registration.

b.-) Sending a letter with the money (a little fee of 25 US$) and the Registration Form to:

Xavier Cirac
c\ Batlles , 4
Premia de Mar , 08330
Barcelona
SPAIN

After receiving your registration mail, I will e-mail/mail you with your registration login and 
password so you can enter them to the program.

If you need multiple licenses of Wave Flow, you will have a very hard discount:

1 license: 25 US$
1-4 licenses : 23 US$ (8%)
5-10 licenses: 21 US$ (16%)
>10 licenses: 18 US$ (28%)

Thanks for registering Wave Flow.

Registration Form



Registration Form

Please Print the next form and fill in the information (if applicable) when you send me the 
registration letter:

Product: WAVE FLOW 3.x
Company: _________________________________________ 
Name: _________________________________________ 
E-Mail: _________________________________________ 
Address: _________________________________________ 
City: _________________________________________ 
State/Province:          ______________________________________ 
Country: _________________________________________ 

Optional

Where did you find Wave Flow?
_____________________________________________________

What are you using Wave Flow for?
_____________________________________________________



Audio Related Sites (Internet)

This submenu will help you to find the most interesting audio related places (as well as some 
General sites) on the net. They are all rated and commented and they are perhaps the most useful 
sites to find software, help, tips, links, wav files...



Divide into multiple files

This option will be useful with the large wave files (>50 Mb) if Wave Flow seems to go too 
slow or gives you any memory error. Using this function you will be able to divide large wave 
files into pieces so Wave Flow can handle them.

After that, you can use the function Concatenate multiple files to concatenate all the 
waveforms one behind the other.



Concatenate multiple files

This option is useful when the ‘Divide into multiple files’ function has been used or when 
you need to concatenate multiple files in one target file. It takes the data of each selected file 
(selected with the ‘Add’ button), and concatenates them in one final file using the PCM format 
(Channels, Bits per sample,...) of the first file. It is very important to be sure that all the files are 
PCM waveforms and that all of them have the same format :    Channels, Samples per second, 
Bits per sample, ...



Zero Crossing

Zero crossing is a function that lets you adjust the selection to match the zero crossings of the 
waveform (the samples where a change from positive to negative value is found), in order to 
preserve the sound phase and to get a better adjustment and behavior of the paste, repeat, mix 
and other functions.

In the submenu, a lot of zero crossing options can be found in order to select the directions of 
the selection adjustment.



Edit menu

The Edit menu not only has all the typical actions that all the clipboard functions that most 
Windows programs usually have in this menu (ex: cut, undo, copy, paste...), but also has some 
specific functions related to the audio processing programs (ex: rap, mix, insert and force 
silence... ). 

The functions in this menu are:

- Undo
- Cut
- Copy
- Paste
- Paste as new
- Mix
- Repeat
- Delete
- Trim
- Insert silence
- Force silence
- Select all
- Go to the cursor position



Undo

This option lets you undo the last action made to the waveform (the last modification), so 
there is the possibility to undo the mistakes that can be made.

Undo information is automatically save to a temporary file called wavedesh.tmp in your 
Wave Flow directory before you do anything that will change the waveform being edited. 

Press Ctrl+Z to quickly undo the last operation.



Cut

Cut will copy the selection to a temporary file called wavecopy.tmp in the Wave Flow main 
directory, and remove it from the waveform being edited.    Once cut, it can be Mixed o Pasted to 
other waveforms.

Use CTRL+X to quickly cut the selected wave.



Copy

This option realizes the same actions that the Cute2 option, but without deleting the selection. 
The selection will be copied to the temporary file called wavecopy.tmp to use it later with the 
functions Mix or Paste

Use CTRL+C to quickly copy the selected wave.



Paste

This options lets us insert the piece of wave that has been already copied or cut with the 
functions Copy o Cut. With this function different waveforms recorded in different moments can 
be added in the same waveform file. The selection will be pasted in the cursor position.

It is also accessible with the Ctrl+V shortcut.



Paste as new

This functions realizes the same that the Paste function, but creating a new child window 
where the selection already copied or cut will be inserted to. With this function we get a new file 
(initially without name), where we can edit the waveform without modifying the original audio 
file.



Mix

This function realizes a union of the actual waveform and the piece of waveform that has 
already been copied or cut. The result is a mix (a superposition) of the samples that we have been 
cut or copied and the samples of the actual waveform, starting on the cursor position. 

This option is also accessible using the Ctrl+M shortcut. 



Repeat

This function repeats the actual selection after the selection end. 

This option is also accessible using the Ctrl+R shortcut.



Delete

This function lets us delete the actual selection of the active window. It is not the same that 
the Cut function, because now the selection will be loosed, not cut (only recoverable using the 
Undo option.

This option is also accessible using the Ctrl+Del shortcut.



Trim

This is the complementary function of Delete, because it deletes all the waveform except the 
actual selection.



Insert silence

This function inserts samples with an amplitude value = 0. This means that it inserts silence. 
The length of the silence inserted will be the size of the selection when this option is selected. 

This silence will be inserted after the beginning of the selection, moving all the later samples 
after the end of the silence that has been inserted.



Force silence

This function takes the samples of the actual selection and force them to 0. This means that 
they will be silenced, so you will hear nothing.



Select All

This option selects all the waveform and displays the whole sound in the window, selecting it 
all. This means that the zoom, begin and size values of the selection bar will be modified. 

You can also access to this function doubleclicking the status bar of the window that we wish 
to fully select.

This option is also accessible using the Ctrl+S shortcut.



Go to the cursor position

This function displays the waveform beginning in the sample that is written in the edit box 
called "Begin" placed in the selection bar of the main window of the program. This functions 
free us of having to look for the cursor all over waveform using the scrollbar manually. 

This is a useful function when the zoom values are small. 



Xavier Cirac

This is my name and I am the author of all you can see in this program. I have been working 
with some wave editors and I decided to build my own audio program, trying to get the best 
functions of all the other wave editors, and keeping off the useless options of all of them.

This software has been programmed using Borland Delphi 3.0© (a fantastic programming 
tool that gives a visual and easy way to make Windows programs).

I started programming this software in 1997 (March), and I am still working on it to get a 
better program. If you have any doubt about it, or find any mistakes or bugs please send me an e-
mail to the address: <xevi@100mbps.es>. I will be very happy if you do so. If you wish to give 
me ideas for later versions, or give your opinion of something related to the program, you can 
mail me too.

To get a description of the program characteristics please click the next label:

Wave Flow



Filter Menu

Using this menu, you can access to all the filters (time filters and frequency filters), and all 
the functions related to the frequency domain. The functions that you can find in this menu are 
the next:

- Filter bank
- Advanced filter
- Median filter
- Improved median filter
- Average filter
- Top Hat    filter
- Add noise
- Equalize
- Dynamic expander
- STSA
- Edge Enhancement



Filter bank

This option shows a dialog box    where a list of some predefined filters can be found. The 
values of this filters are fixed but they are the typical filters that you can find in any audio editor, 
so if you wish to configure any of them, you should use the function Advanced filter. Those 
filters, will    delete or increase some frequency components of the sound (low, medium or high 
frequencies) to get different effects.

This function eases the use of the most common filters. 

The predefined filters that you can choose in the selection list of the dialog box are:

- Low pass filter 2K
- Low pass filter 5K
- Low pass filter 10 K
- High pass filter 60 Hz
- High pass filter 100 Hz
- High pass filter 1K
- Bass Boost
- Bass cut
- Treble Boost
- Treble cut
- High Boost
- High cut

You can quickly access this functions using Ctrl+B.



Advanced filter 

This is, perhaps, one of the most important functions in this program. It lets us realize a 
personalized filter, because with this function we can configure a set of parameters that will 
modify the response of our filter, making it more or less selective. When this option is selected, 
the next dialog box will appear:

At the top of the dialog box a frequency representation of the Fourier transform (FFT) of the 
peace of waveform selected will appear. Using the buttons of its right, we can select if we prefer 
a linear-linear representation, or a semi-logarithm representation (Y axis in logarithm scale and X 
axis in linear scale). This frequency representation will guide us to realize our filter. The rang of 
representation is: 0 Hz (offset component) to half the sample frequency (due to the Nyquist 
theorem).

Under the graphic we will find two trackbars that will let us select the low cut frequency and 
the high cut frequency of the filter (this response of this filter is represented with a red colored 
square on the frequency representation). 

The selection box on the right of the dialog box, will be used to select the action that we wish 
to realize with the selected range of frequencies. This functions are:

- Delete: Deletes the frequency components included into the selected range (force them to 
zero). 
- Boost : Increases the value of the frequency components included into the selected range. The 
ratio factor that will be used, can be selected with the small trackbar situated under the selection 
box.
- Decrease: : Decreases the value of the frequency components included into the selected range. 
The ratio factor that will be used, can be selected with the small trackbar situated under the 
selection box.
- Band pass filter: Using this function, all the frequency components that are not included into 
the selected range will be forced to zero. This is the default option.
- Window Size: You can select the size of the FFT used in the filtering transformation 
(>Window Size means >Spectral ressolution & >Processing Time).
- Overlap: You can choose the overlap into transformation windows.
- Window Type: It shows the available windowing functions (Rectangular, Hamming, Hanning, 
Barlett & Blackman)

We can see that combining all the options of this function, all the filters of the option Filter 
bank, can be done (and many more!).

You can quickly access this function using Ctrl+F.



Median filter

This option realizes the 3x3 median filter of the selected peace of waveform. 

This filter realizes the median of the actual, anterior and posterior samples and assigns it the 
value of the actual sample. The median of three numbers is the value that is neither the lowest 
nor the highest.

The median filter is used to delete the scratch noise.

Improved median filter

This option realizes the 3x3 median filter of the selected peace of waveform. An improved 
median filter is a median filter with a threshold (under this threshold the signal will not be 
modified).

The median filter is also used to delete the scratch noise, being a little bit "cleaner" the 
median filter.



The scratch is a high frequency noise due to the saturation of the signal. For example, one of its causes can be 
the little jumps that the record player needle does when playing a record.



Average filter

This option performs the 3x3 average filter of the selected waveform. To do it, the arithmetic 
average of the actual, past and next sample is done, and the result of this operation is assigned to 
the actual sample.

In fact, this is a low pass filter because it deletes the high frequency changes. 



Top hat filter

This option performs the 3x3 top hat filter of the selected waveform. 

A top hat filter is a very useful filter to delete the scratch noise because it is a filter that only 
deletes this kind of noise, without modifying the signal that has no noise. It is perhaps even 
better that the median filter, because it is cleaner with the parts of the waveform that don't have 
scratch.



Add noise

 This function add random noise to the selection of the actual waveform. The result that you 
can hear, is that a fried noise is added to the signal.



Equalize

This function shows a dialog box where an octave equalizer is displayed, whose attenuation 
values can be selected for each octave using a mobile trackbar. An equalizer is useful to attenuate 
or increase some frequency ranges, to increase the sonority of the waveform.

The mobile trackbars scale is in dB (decibels), and the frequency scale is in Hertz's (Hz).

This option is also available using the Ctrl+Q keys.



Dynamic expander

This option lets us perform an expansion of the dynamic range of our signal (number of dB 
of intensity variation that the emitter can generate), and in some cases it is useful to add richness 
to our waveform. 

When this option is selected, a dialog box is shown, where the ratio of increase or decrease 
can be selected. This ratio is the value of the filter that will be applied to the waveform to expand 
it. If this value is greater than 1, this function will actuate as an expander, but if it is lower than 1, 
it will actuate as a compressor. If a too high value is used, the signal can be saturated, so the 
effect that we wished to get won't be reached.



Thanks

This program has been done thanks to the help of : 

-Carmina Boter
-Eloi Solà 
-Léonard Janer
-Màrius Flaquer.

… and all the Wave Flow users who have sent me emails with ideas, improvements, errors and 
bugs.
… and all the registered users who have given me the strength enough to continue with this 
project and developing new versions of it.

Thanks to all of them.



STSA

This function (Short Term Spectral Attenuation) can be used to get an enhancement of 
musical signals and speech signals degraded by background noise. Since many old recordings 
suffer from an excessive background noise, it is nowadays common to use a digital noise 
reduction system. The principle of STSA method is to attenuate those values of the short-time 
Fourier spectrum of the noisy signal that are strongly corrupted by noise. Its drawback is that the 
noise reduction is obtained only at the cost of some amount of signal distortion. In the case of old 
disk recordings, the level of the background noise is generally so high that this technique can 
generate audible distortions, but on the other hand, playing with different configurations of the 
parameters of the STSA form you can get pretty good enhancement. This function is useful for 
sounds that suffer from background noise (low frequency) if your sound also suffers from other 
kind of noise (gaussian,…) you should also use other functions like Median filter, Improved 
median filter, Average filter, Top Hat    filter, …

You can set the next variables:
-Noise power: It is the power of the noise. If you don’t know which value to use, you can get a 
good estimation of it using the function “Histogram” with a peace of waveform that has not 
signal (I mean that it is only background noise).
-High SNR threshold: It is the value of the SNR (signal to noise ratio) from which the signal 
won’t be modified.
-Minimum SNR threshold: Every frequency component which SNR is smaller than this value 
will be put to zero.



Edge Enhancement

This function enhances the edges of the waveform. Its result is similar to a high frequency 
increase.



Tools menu

In the Tools menu you will find the general functions that will let you modify the waveform, 
adding lots of useful effects.

In the Tools menu you will find the next functions:

- Speed Up/Down
- Resample
- Reverse
- Invert channels
- Travelling stereo
- Normalize
- Fade In
- Fade Out
- Amplify volume
- Echo
- Reverb
- Effects
- Remove Offset



Speed Up/Down

This option displays a dialog box where some options can be configured, making the 
waveform faster or slower. This is performed resampling the waveform adding or taking off 
samples by interpolation. For example: If the speed is set slower, this will mean that the final 
number of samples will be increased. The final number of samples of the selection, can be easily 
selected through the edit box called 'Estimated number of samples'. This is very useful because it 
lets you synchronize the speed of two waveforms, only knowing the pitch or the period between 
two drums hits of one of them .

In this dialog box you will find as well the actual length of the selection (in samples), and the 
increase or decrease percent. All this information will determine the final length of the selection.

This option is also accessible with the Ctrl+Alt+V Shortcut



Resample

This option shows a dialog box that will let you change the actual format of all the active 
waveform. 

In this dialog box you can find the actual format of the file of the active window, and three 
selection lists that will let you change the final format of the file. You will be able to change the 
number of samples per second, the number of bits per sample and the number of channels.

Once all the modifications have been done, the waveform will be shown with the new format.



Reverse

This function will let you change the order of the samples of the current selection. Once this 
function is called, the last sample of the selection becomes the first, and the first one becomes the 
last. This is makes the same effect that playing a record on the inverse direction.
 

This option is also accessible using the Ctrl+I shortcut.



Invert channels

This function is only accessible when the current waveform is stereo, because it performs an 
interchange between the two channels (left and right). 



Travelling stereo

This function is only accessible if the current waveform is stereo.

This effect increases the volume of one channel while decreases the volume of the other one. 
It creates the effect that the emitter of the sound is moving from one side to the other.

By selecting this function, a dialog box will be displayed, where the direction of the 
movement can be selected (left to right or right to left). The percent of increase and decrease can 
also be configured. 



Normalize

This function increases the volume of the actual selection of the active waveform, until its 
maximum value reaches the maximum value that the format allows. This function will increase 
the volume of your waveform, but without saturating it. 



Fade In

Fade In will performs a progressive increase of the volume of the waveform making the 
initial volume lower than the final one.

This function will display a dialog box with some options to configure. First of all, there is a 
track bar that will let you select the percent of the initial decrease of the volume of the waveform 
(the final percent will be 100%). Secondly, you can also select the kind of function that will be 
used to increase the volume (linear, exponential or logarithm).

This option is also accessible using the Ctrl+Alt+I Shortcut.

Fade Out

Fade out is the complementary function to Fade in, because it performs a progressive 
decrease of the volume of the selection of the current waveform, beginning with a 100% of 
volume and ending with the percent that you can select using the track bar.    You can also select 
the kind of function that will be used to increase the volume (linear, exponential or logarithm).

This option is also accessible using the Ctrl+Alt+O Shortcut.



Amplify Volume

This function is useful to change the amplitude or volume of the current selection. You can 
change the percent of increase or decrease using the either the track bar or the manual 
configuration (writing a number into the edit box). A percent of 100% will leave the waveform 
with the same volume. Selecting a higher value, the volume will be increased, and selecting a 
lower value will decrease it.

This option is also accessible using the Ctrl+Alt+A Shortcut.



Echo

This function adds an echo effect to the waveform. You can choose between a simple echo 
(only one repetition) or a multiple echo (various repetitions). If you select "multiple echo", if can 
also configure the number of repetitions to perform.

This option is also accessible using the Ctrl+Alt+E Shortcut.



Reverb

This option displays a dialog box where the reverb parameters can be configured:

- Reverb time: Is the total delay time of the reverb. As high is this value, as big is the room you 
wish to simulate.

- Initial delay: It is the delay between the direct sound and the first reverb rebound.

- Reverb delay: it is the delay between the first reverb rebound and the big group of reverb 
components.

- Density: It means the number of reverb rebounds that will be generated. As high is this 
parameter, as dense and unintelligible will be the result sound.

This function has also some predefined options representing the most common rooms, to 
easy its configuration. 

This function is also accessible using the Ctrl+Alt+R shortcut.



Effects (FX)

Wave Flow, has an small effects bank, that includes some curious effects and some of the 
effects given with the digital effects processors. They are:

- Telephonic Line: This effect performs a band pass filter using the telephonic bandwidth 
(between 300 Hz and 3400 Hz). 

- Robotic voice: This effect simulates the voice of a robot.

- Distortion: This effect makes a distortion to the sound. All the samples whose value is 
higher than a configurable threshold are substituted by random noise added to the selected 
threshold. As low is the threshold you choose, as distortion you will get.

- Compressor: This effect compresses the dynamic range of the signal. All the samples 
whose value is higher than a configurable threshold are compressed by a configurable ratio. As 
low is the threshold you choose, as compression you will get.

- Expander: This effect expands the dynamic range of the signal. All the samples whose 
value is higher than a configurable threshold are expanded by a configurable ratio. As low is the 
threshold you choose, as expansion you will get. Another expander is the dynamic expander

- Noise Gate: This effect is used to remove the background noise (that is currently a low 
intensity noise). To get this effect, all the samples whose value is lower than a configurable 
threshold, are forced to zero.

- Quantifier: This effect divides the signal in a few values, rounding the value of the samples 
to the nearest one. For example, if you have a 8 bits sound (255 different levels), and you can 
quantify it to 9 different levels (0, 32, 64, 96, 128,160, 192, 224, 255). This effect adds a 
quantification error due to the loss of quantification values. 

- Karaoke: This function attenuates the frequencies used by the human voice (300/3400 Hz) 
to simulate a karaoke.

- Metallize: This effect adds a metallic effect to the sound by periodically forcing some 
values to zero (this means that some high frequency components are created). Depending on the 
period used and the number of samples forced to zero, you will have a Soft metallization or a 
Hard metallization.

- Chopper: This function inserts periodic blank spaces into the sound (samples whose 
amplitude is 0). 

This function is also accessible using the Ctrl+Alt+E shortcut.





Remove Offset

This function removes the continuous component of the selection of the active waveform. 
This is done by calculating the average of the selected range. It has no any audible result, but it is 
useful if other functions like digital filtering have to be used.




